Eudora: @ Workstation & Microcomputer Facilities

) Information Systems & Technology
e-mail for your PC

Fudar University of California at Berkeley

The W&MF staff has prepared this document for you so that you can familiarize yourself with the basics of Eudora
(version 3.03). This document is meant to serve as a future reference for you. It covers from the very basic to the
fairly detailed. Not all the information mentioned in this document will be covered in the Eudora for PC class.
Before taking this course, you should be familiar with the Windows (PC) computing environment or have
completed the Introduction to PC class.

What is Eudora?

Eudora is a full-featured Windows application that allows users to communicate with each other by
sending and receiving electronic messages.
Using Eudora, you can:

- Read and send mail

- Save malil to a file

- Organize saved messages into mailbox files

- Send attachments (such as word processing or graphics files)
In addition Eudora allows the sending and receiving of formatted documents through the network with
automatic file conversion.

Why would | want to use Eudora over UNIX or PINE?

Eudora takes mail from the Unix machines and saves it on your Windows disk drive. The primary
difference with Eudora is that it works on a POP (Post Office Protocol) server. When checking your
mail with Eudora, you never truly log in. Your incoming mail arrives at the POP server, where it waits
for Eudora to pick it up.

Getting Started

Requirements

Mew Office Document
- Before you can use Eudora, you will need to have an e-mail ~u :

' . Open Office D t
account on a UNIX host that is running a POP3 Server. E7 el
Examples of such accounts are the uclink machines,
garnet, socrates, etc. Eudora does not receive mail directly; Erograms
it needs the POP server to act as an intermediary to your

UNIX account. Most .berkeley.edu e-mail accounts run on a @ Documents
- \F()SJPaIS:oNr?eréd one disk. [@ Selliz 1
Where can | get Eudora? @ Find 4
Networked users can obtain Eudora from the facilities. @ Help
Under Start > Programs > Networking > Eudora Pro. ZEl
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Starting up Eudora

To start Eudora, click on the Eudora Pro bar. You will be asked to place a pre-formatted 3.51

disk into the A: drive. The Eudora menu bar will appear:

" Eudora Pro

I [=] B3

Eile Edt Malbox Meszage Tranzfer Special Tools Window Help

= =il [ e G [ == o =

‘ﬁ %@B@Ee “====*‘@ABE ﬁ‘ "t?
Configuring the Settings
Il findowe Help

When you use Eudora for the first time Filters
you will need to edit the Configuration Wiew Mailboves
so that Eudora knows who you are and AddressBook Gl

where to go to retrieve your mail. To

customize the Configuration, go to the

Tools menu and select Options...

Once you do this a dialog box will pop

up on the screen. Make sure you fill
out the four boxes in the Getting
Started section.

Enter your email address into the
POP account field, i.e.
smole@uclink4.berkeley.edu

Enter in your name as you want it

to appear under the From section of
your emails in the Real Name field.
If you want messages to be sent to
another account when the recipient

returns your mail, enter it in the
Return address field.

Directory Services  Chl+y

Signatures 3

A L 1 |

Real name:

Hesbmn addiese:

Conmection Method:
& winzock [HMetwork, PPFP, SLIP]

0 Skl GCcdlind &b e

I Diflen e [ oo eclioe |

Cancel

Settings Window

Note: most account names are lower-case, and many POP servers are case-sensitive, and
will consider the correct password not valid if your pop account is not entered in lower-case!

That's all you need to do to get started. Click OK. You are now ready to read and send mail
with Eudora. There are a few other sections in the Options... dialog box with settings that

Introduction to Eudora

page 2 of 12

Last edited 05/27/99



you can set to customize Eudora. Some of the more useful options are discussed at the end
of this handout.

Using Eudora

Reading Mail
To collect your mail, select Check Mail from the File menu. Eudora will ask you to supply the

password for your email account. Eudora will then log in to the POP server to see if you
have any mail waiting. If you do, Eudora will automatically download it. A listing of your new

mail will then appear in the In mailbox window. Unread messages are marked with a bullet -.
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f Eudora Pro
Eile Edt Malbox Message Transfer Special Tool: Window  Help
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- Chuck Xiong 0 e
L George Washingto 03:2Z5 PM 1075795 1 Eeep up the good work.

ZHAKIIR [] | II
For Help. press F1 MUK |

In Mailbox Window

To read a message, double-click on it. A window will come up with the text of the message,
along with a header saying whom it is from, the subject, when it was sent, etc.

You can also read other mail by clicking on the Out or Trash button on the menu bar.

Sending Mail PRl Tiowfs Speciel Tods

To send a message, select New Message from the m‘
Repl CisA

Message menu.

A new composition window will come up with the blinking cursor situated at the start of the
To: field. Each of the fields (i.e. To:, From:, Cc:, Bcc:, and Attachments:) are explained in the
diagram below. (For those that are familiar with PINE, these are the same fields as when
you compose a message.) After you fill in the fields with the necessary information, you can
then edit the body of the message as you would with any Windows word processor. When
you are finished, you can click on the Send button and Eudora will send your message.
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Ex Mo Recipient, Ho Subject

l| <nores =l e jarisglE ] ) B |RR Send

To: I -
From: Joe 3mole <zmolefuclinkds
Subject:
Cc:
Bcco:
Attachments:
|

Mail Message Window

Creating Signatures
A signature is a brief message automatically added by Eudora to the end of outgoing
messages. Usually it consists of a few lines giving the sender’s name and e-mail address.
Other pertinent details such as phone number, postal address, or place of employment are
also sometimes included.

Eudora supports the use of different signature. To create a
signature, go to the Tools menu and select Signatures.

Window Help

Filters
Wiew Malboxes

The menu will give you the option of making a new signature or

to delete an old one. To make a new one, just click on new and | Address Book Chl+L
give it a title, then enter the signature you would like to attach to ' piectom Semices Chley
the end of your email. s
Signatures 3
Optians. ..
" Eudora Pro S[=] E3

File Edt Mailboy Message Transfer Special Tools Window Help

S EEEE R R B
New xi
Joe Fmole i

Thiveristy of California at Berkeley
smnle[guclinkd.her}:eley.Edu

1
(|
1
|

=
=

For Help. press F1
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Once | created a signature, how do | use it?
At any time while you are composing a new message, you can tell Eudora whether or not you
want to include a signature and which signature to use if you have more than one. At the top
of the New Message window, there are various icons that let you customize your letter.
(These icons are individually explained at the end of the document.)

By clicking on the signature icon, you will see a menu of the signature options. Standard | :
Just highlight the desired option and you are set. Note: The signature text is not | cnanes

displayed at the end of the messages you create, but your recipients will see it.

Mew

Replying to Mail

(B30 Transfer Special Toolz W

To reply to a message, with the message window open, select
Reply from the Message menu. New Message Chil+N

1

Eudora will create a new message window with the text of the original message quoted, and
the address of the sender automatically inserted in the To: field. You can edit this message
as you would any word processing document. Unlike UNIX and Pine, Eudora supports the
use of a mouse to select and delete areas of text. You can also add in certain formatting like
bold/italics text, bigger fonts, etc. However, please note that not every user will have an email
program that supports these extra features. It is more useful to just type a message with the
default text settings.

Deleting Messages
If you do not want to keep a message, you can highlight it in the In mailbox (or any other
mailbox) window and select Delete from the Message menu. Eudora will put it into the Trash
mailbox. As a precaution, it is not yet really deleted. If you change your mind, you can
retrieve it from the Trash by highlighting it in the Trash mailbox window and using the
Transfer menu to put it in another mailbox.

More Advanced Features

Sending and Receiving Files
If you would like to attach a file with your mail message, Eudora can do that for you. You can
even send formatted files an Excel spreadsheet or a MS Word file for example without having
to do any special formatting beforehand. Eudora will automatically encode the file into a
format that can be sent with the mail.

To attach a file to your message:

® Under the Message menu, select the @ Select the file that you want to attach. We will attach
Attach File option. the file plan.doc as an example.
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Special T Attach File X

Chrl+M ;
File name: Folders;
CirleR [FERDVE b i | dttach |
. Cancel
— = =
i SIGS |
Hedinect Standard.kt &
Send Again
Mew Meszage To » 1]
Forward Ta k _;_! =
Redirect To ¢ Lizt filez of tupe: Drives:
Mew Meszage Witk 3 Iﬁ" Files [*.7] .ﬂ I B a LIJ
Reply 'fith »
Attach File Ctrl+H
Send Immediately  Cil+E
LChange ]
Delete Ctrl+D

® After you have selected the file you want to attach, Eudora will list the

file with its location in the Attachment: field.
Tw: I
From; WJoe Smale Cemolefaelinkde
Subject.:
(4=}
Bro:
Atkachments; A 5105 PELDAE . THT;

The attached file functions like a rider to the e-mail message. It does
not appear within the message text. To delete the file you don’'t want
to attach, select the link where the attachment file is displayed and
press Delete.

@ This last step describes how to open up an attached file that has
been mailed to you. When Eudora checks your mail, if it encounters
a message that has an attachment, it will convert it back into the
original format and ask you where you want to save the document.

It will then proceed to download the rest of your mail. If, after reading
your mail, you forget where you told Eudora to save the message,
you can look at the bottom line of the message with which the
attachment was sent. Eudora will list the location:

Aot ek sheed T IR AT OTENS L HEVE RS

To ensure that Eudora converts the file correctly, you may wish to
specify how the document should be encoded when it is sent.

This will eliminate any possible error the recipient may encounter ' BinHex |
with the file. Click on the Bin Hex icon located at the top of the

tool bar where you are typing your mail and select one of the
options:
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Use:

MIME when you are sending to someone using a MIME-capable mail program (MIME
stands for Multipurpose Internet Mail Extensions, which is an emerging set of
standards for sending various types of data through electronic mail.)

BinHex when the person to whom you are sending the file is using Eudora 1.3 or older,
or one of many other mail programs (e.g., QuickMail or NUPop).

Uuencode when you are sending mail to someone who is using older PC or UNIX
systems.

Mailboxes
By default, Eudora is configured with three mailboxes: In, Out and Trash.
In is where Eudora stores your mail
Trash is where Eudora puts messages that you have deleted
Out If you choose to save copies of your outgoing mail (this is an option that is set
from the iSwitches...1 item under the Special menu), they will be saved here.

You can also create other mailboxes to organize your saved messages.
® Select New from the Mailbox menu @ Then type in a name for the new mailbox.

Mew Mailbox

bailbog BEEEESRE
Creating a mailbox in the Top Level

E=Aln Chrl+1
Out Ctrl+0 Harme the new mailbos:
Trazh
’humDrI
[ Make it a folder

ak. I Caricel

Mail can then be transferred at any time between mailboxes by highlighting the message and
choosing another mailbox from the Transfer menu.

Quick Recipient List

[G[3EEDEN Tranzfer Special Toole W
Under the Message menu are the items Mew Message Chil+N

used to send mail, reply to mail, etc. Below :
this first list is another group of the same

items, but with a right arrow at the end of HeveMe e i 4
. . Forward To g
each item. This right arrow allows you to see el

more details related to that item you
selected.

If you select New Message To from this second list and
drag the cursor to the right over the arrow a pop-up list will
appear that contains a list of e-mail addresses. For now it
should be empty.
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If you would like to add a recipient to this list, all you have to do is highlight an e-mail account
name from some mail that someone has sent you, for example, a nickname, and then choose
Add as Recipient from the Special menu. In the example below, | received a letter from
johnkim@cafe. | will be mailing this person multiple times in the near future, so to save myself
the energy of typing out his complete address every time, | will add his address to my recipient
list. To do this, | just highlight his e-mail address from within the message, go to the Special
menu and select Add as Recipient.

pefeiE 1l Tools  Window  Help
Filter Meszages Chrl+]
o B0 B 2 K[ v| Subl ke Fier

Date: Thu, 27 Aug 1998 16:32:37 .07 Make Addiess Book Enfty.., Tl

"John D. Kim" <johnkimi@caf

; &dd az Recipient
To: helengee@uclinkd. berkeley. edu =55 or e Recipient h{ ,,,

Subject: Hey, lsn't Eudora Cool?

When | go back to the Message menu and select New Message To, | will see his address as
an option:

MHew Mess “John 0. Kim'"* <johnkimieicate. berkeley.edus |

Creating Nicknames/Aliases

Eudora supports nicknames, or aliases as they are called in QT indow  Help
UNIX mail. For example, you have a friend who has an Filters |
account at UCLA. Instead of typing out : .
erin@bambam.ucla.edu each time that you send that person a FETERET ‘
message, you can create a nickname by choosing the e
Address Book item from the Tools menu.

A dialog box will appear prompting you for NewNickname  EH|

the name of the new addressbook entry. In
our example, we want to create a nickname
erin for the account JEqirl

erin@bambam.ucla.edu. If you \(vant this in Aduhess Book: [ udora Nicknames 7]
nickname to show up on the Quick
Recipient list under the Message menu,
check the Put in on the recipient list. L_iHakekan s sona] =

Then, click OK. :
Ok I Cancel |

WWhhat do pou wizh to call it?

[ Butit on the recipiert list
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The new nickname is
displayed in the Nickname
field of the window and the Eudara Micknanes
insertion point is placed in 3 Erin

the Address(es) field.
Make sure that Nickname
is indicated in the selector

Yiew By (TR Addessles) ] Mates | Irfa |

eringbarmbam.ucla. edy

box.
Here, type in the full e-mail | L] [+]
address, in this case: New | Del v |

eri n@anbam ucl a. edu
To | Cc | Beo: |

When you close the dialog FiE iR

box, you will be asked if
you want to save the
changes you have made.
Once you have saved the
nickname, you can type the
nickname instead of the full
email address.

Creating a nickname for a group of people
If you regularly want to send mail to a group of several people, you can create a nickname for the
group. Open the Address Book window, click on the New button under the Nickname field window,
type in the nickname for the group, hit the tab key and type in the e-mail addresses of the people in
the group in the Address(es) field. Be sure to separate each person’s address with a comma or
return.

Wiew Buy: INicknamE "I &ddress(es) I hotes I Irfo I

Eudara Micknames

: chuckigcafe berkeley. edu, erincafe. berkeley. edu,
ez friends vani@ cafe berkeley edu johnkimi@ cafe berkeley.edu,
[ ] gnguyen@cafe berkeley edu, daviduu@cafe berkeley edu,

! helenges@cafe. barkeley. adu

ﬂewl Del I 44 |

To | Cro | Bor: |
[T Ezpand Mickname
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Quick Reference Guide

This section of the document describes the various icon buttons and settings of Eudora. This is
to help you have a greater understanding of what Eudora is capable of.

New Message Icon Bar
In each new mail message window, there is an icon bar that appears at the top of the window:

|| jl Standard j M'MEjHE!F'|||*| |@ ER ||\3/' Send

There is a check mark next to some of the icons, which means that the option the icon
represents is on by default. If you want that option to be in use for a particular message, you
can click it with the mouse and it will be toggled for just that message.

||_L,| When selected, brings up the pop-up priority menu:

With the Priority Menu, you can rate the importance of
the message you are sending. A respondent using
Eudora will see the corresponding symbol in both the
In mailbox and when the message is open.

| kI I The BinHex icon is explained on page 6

|[E] When the Word Wrap Icon is set, Eudora will automatically word wrap
(start a new line) at the end of a line as you type.

|| Standard j The Signature icon is explained on page 4
T

b

I When the Tabs in Body Icon is set, entering a tab in the body of a
message will move the insertion point to the next tab stop by inserting
spaces. Tab stops are located every eight spaces. Otherwise a tab in the
body of the message will move the cursor to the To: field.

When the Keep Copies Icon is set, Eudora will keep a copy of each
message that you send in the Out mailbox. Initially it is off. If you want to
keep a record of your correspondence, you can turn it on in the Switches
dialog box.

[ When the Text as Attachment icon is set, text files are included as
separate attachment files, not in the body of the message.

RR | When the Return Receipt icon is checked, a cooperating mailer will return
a message to you notifying you when your outgoing message is delivered
to the addressee. The return receipt is placed in your In mailbox.

-4 Send | Send: Clicking on it sends your message when you are done editing it.
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Tools - Options Menu settings

Auto-Checking Mail

Eudora has the ability to check for mail
automatically at set intervals. This
feature can be set from the Options...
dialog box under the Tools menu. Then
select the icon for Checking Mail. Enter
the interval that you want. If you enter a
0 or nothing, then Eudora will only
check mail when you select Check Mail
under the File menu (the default).

(This option should not be set for
checking mail more often than every 10
minutes.)

Reply Features

When you reply to mail, Eudora will
send your reply only to the person who
sent it to you. If you wish to include the
other people that the message was
addressed to, click on the Replying icon
and select Map Ctrl+R to Reply to All.
Then when you reply to a message, hit

ctrl+R to reply to all people on the email.

If you want to send yourself a copy of
the email message, check the box for
Include yourself.

Leave Mail on Server

Lateyg

[

Gedling Farted

L]

POP sccomnt: |smolo@ucnkd borketey. odu

Chack For mail vy |lﬂ minbex
Téll:mﬂagﬂnml-iﬂ F in size
® Semd on check
[~ Saye password
™ Leave mail on seaver
™ Dolete bom seiva alta F s

Dstermine firel unesd mescags by
(W Firgt makgzage ol ol by this machine
[ Gratur foadens
' POP3 LAST command

[ Dulsin bom =orvm whos smolisd o Teash

) it et or byl
Swrling Madl ¥ Passwords [ Lol AP
t, = [ox ] [ cown |
Dptions EE
LCateqary:
«| [ Map Cil+R to “Feply to &I
6?& ™| Copy ariginal's pricrity to reply
Getting Started ™| Automatically Foc ta onginal mailbos
v
Wwhen replying to all:
Checking Mail [ Include yourself
4l ] [ Put ariginal To: recipients in Cc: field
-
|ncarmirg b ail
=
Sending Mail
Feplying
‘;Dl ;_I k. I Cancel

Another option available is to leave mail on the server. This is useful if you wish to read your
mail both with Eudora and by logging into your UNIX account. For most people, it is better if it
is left off, otherwise your mail would build up on your account. If you do want to leave a copy of
your mail on the server, mark the Leave mail on server option under Options: Incoming Malil
icon. You can also enter in a number for the number of days read mail stays in your account

before it is deleted.
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Keep Copies

If you want a record of your correspondence, set this option and Eudora will keep a copy of all
your out-going mail in the Out mailbox. You can toggle this option by using the Return Receipt
icon in the New Message con Bar. To set this option permanently, mark the option under
Options: Sending Mail icon and Keep Copies.

Save Password

Unless your Eudora folder is in an area where no one can access it, it is a good idea to leave
this option off. If it is on, anyone can launch Eudora from your Settings File and send mail or
download mail from your account.

If you want to toggle this feature on or off, go to Options: Checking Mail icon: Save
Password.

Conclusion

By this time, we hope that you have a fairly good idea of some of the commonly used features
of Eudora Pro 4. Even though there were plenty of features that were not covered, we hope
that you will find all of the information presented useful. If you have any questions, please ask
the Instructor or Roamer. Also, try to experiment with the topics covered, and see what you
can create as well.

Remember to fill out an evaluation before you leave, and thank you for attending Introduction
to Eudora Pro 4.
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